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1.0 Introduction

1.1 Overview

The cryogenic frost point hygrometer accurately measures water vapor at elevations
from the earth’s surface to the mid-stratosphere. The instrument has a significantly
greater sensitivity to water vapor than standard radiosondes, as it can measure
amounts at the parts-per-million level. The sonde design avoids the costs associated
with aircraft-mounted instruments.

1.2 Hardware and Software Requirements

The CFH sonde requires the following hardware and software for successful operation:
The CFH sonde requires the following hardware and software for successful operation:

e EnSci DAS-2A data system with STRATO software

e CFH sonde

¢ InterMet 1-RS radiosonde

e ECC ozone sonde model V7 (optional)

e CFH mirror cleaning supplies (cotton swabs and pure methanol or ethanol)

e 0.035 inch hex screwdriver

e F23 or R23 Freon (trifluoromethane) cylinder (it is strongly preferred that the
cylinder contain a siphon or dip tube for liquid withdrawal)

e Solid CO2 or dry ice

¢ Insulated box for Freon cylinder

¢ Insulated container to hold up to 300 ml of liquid Freon

2.0 CFH.setup Software

CFH.setup is used to prepare a CFH for flight and provides a graphical user interface to
display the CFH output during checkout.

2.1 Installation

CFH setup is installed by running the routine setup.exe. This will install the default
configuration for the Intermet version of the CFH.

DOC-0386 Rev B
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This installation process will also install the LabView runtime environment as well as the NI
VISA runtime libraries.

During the installation of CFH setup, the following directories will be created:
e C:\Programs\cfh.setup—the main installation directory
e C:\Programs\cfh.setup\bin—holds the executable code
e C:\Programs\cfh.setup\data—holds all log data and, firmware, and calibration files
e C:\Programs\cfh.setup\support—contains the setup routine to the Tl download.exe
program, the driver files for the SlLabs USB drivers, and the documentation
2.2 Connecting a Computer to the CFH

The version 2L CFH series requires a USB cable to connect to the computer. Figure 1
shows the version 2L electronic control circuit, with the USB computer bus
highlighted. The connected cable transmits data to the radiosonde.
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Figure 1: CFH Version 2L Electronic Control Circuit
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The first time a CFH version 2L is connected to a computer, Windows will ask for the
drivers. During installation, you will be prompted

On the installation questions answer the following:

e Question: Can Windows connect to Windows Update to search for software?
Select: No, not this time.

e Question: Install from a list or specific location (Advanced)? Select: Browse to
locate the installation location for CFH.setup, then navigate to
C:\Programs\cfh.setup\support\CP210x\WIN. This installation question will be
asked twice. Repeat these steps for the second installation.

Windows will most likely choose COM7 as default COM port, but other COM port
assignments are possible depending on the local computer settings. In the
Device Manager, the appropriate port can be identified.

2.3 Running CFH.setup

First start CFH.setup. It will show blank CFH settings and a status window, which will
show the communication log.

As soon as the CFH is powered on, it will send its settings to CFH.setup. These settings
from the last time the instrument was powered on. If all windows showing CFH
settings have a white background (see Figure 2), then the settings were properly
adjusted the last time the instrument was checked.

The message “Check COM port or CFH Connection” indicates that the serial port is not
available. Please configure the appropriate serial port using the Properties menu. The
message should not appear again if a valid serial port has been selected.

If there is no message after the CFH has been powered on, try any of the following:

e Select File>New Instrument (or CTLR-n) to reset the COM port and the CFH
e Check the COM port selection in the Properties menu

e Check the USB connection

e Check the power supply to the CFH

After the initial power up message, the CFH will not show any further indication of its
operation until a function has been selected.

DOC-0386 Rev B 8
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File Tools

CFH instrument: 34

Sat paint: ' 87.01
Detector signal: | 2.6208
Specular: 3573

Set point temperature: 35.01
ADB30 offset: 0,029

Code versich; 5.24

-CFH setup version 2.1 A

CFH setup loggedin:
(C\Programmelcfh. setupidatal
cfh.setup.log

‘Type CTRL-H for context help

Hygrometer Ver JEEH output wirdow]
? 3 verbous outpur

¢ enker thermistar calibration
5 i set optics

Thermistor 34 calibraticn
A = 240829
B =340582

C = 395647

D= 56590

-Optics settings :

Specy  =3,5733
Bias ¥ - 2.6258

- Optics Temp = 35,2100
- ADA30 offset = 0.0290

‘Ready

Figure 2: CFH.setup Status Window Showing the Initial CFH Message

2.4 Program Control

The Operation of CFH.setup is controlled using three operations:

File > Properties Open the Properties window
File > New Instrument (Ctrl-N) Connect a CFH sonde to the computer
File > Exit Stop the program and clean up

DOC-0386 Rev B
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2.4.1 Using a New Instrument

When using the 2L version CFH, the serial port for communicating with the CFH is
created when the CFH is physically connected to the computer. To control this event,
File>New Instrument (or Crtl-N) must be selected before the new instrument is
powered on. This function will close and re-open the serial port created by the CFH.

2.4.2 Configuring CFH.setup

The Properties menu controls the settings of the CFH setup routine. Most users should
not need to change any settings except for the serial port settings. Note that two
serial ports are available, one for the CFH and one for a pressure sensor.

Figure 3: CFH.setup Properties Window
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CFH data directory:

Configure, where the log files for CFH.setup are being
stored. The default setting is C:\Program Files\cfh.setup\data

Thermistor
calibration file:

Specifies the file containing all thermistor calibration
constants. The default is C:\Program
Files\cfh.setup\data\cal.4point.resistances.dat

Code file:

Specifies the firmware code file to be uploaded to the CFH. The
default is C:\Program Files\cfh.setup\data\hygrometer.hex.
However, the default code file may not be the up-to-date code
within the instrument and should only be used in coordination with
the manufacturer.

Location of
Download.exe:

The location of the program to download the firmware to
the CFH. The default is C:\Windows\Download.exe.

Serial port CFH1:

The serial port used by the CFH. The default is COM4. This serial port
must agree with the hardware configuration of the local machine,
which may be checked with the device manager. Note that with the
2L version CFH, this serial port only exists when the CFH is connected
to the computer. It need not be powered on to create the COM port.

Baud Rate:

This is the Baud rate for communication with the CFH. It is 19200
baud for the 2L version.

Serial Port Pressure:

This option is only for the laboratory options of CFH.setup. It is not
used in the flight instrument preparation.

Low optics temp
limit:

Sets the lower limit for the optics temperature (in °C) at which the
CFH.setup will change the color of the temperature display. This
setting will also change the temperature range in which the Measure
AD630 offset routine will operate. The default setting is 34.

High optics temp
limit:

Sets the upper limit for the optics temperature (in °C) at which the
CFH.setup will change the color of the temperature display. This
setting will also change the temperature range in which the Measure
AD630 offset routine will operate. The default setting is 39.

Allow Programming:

Allows the use of the following routines:

e Load Calibration (CTRL-c)

e Load Program (CTRL-p)
Setting this value to No prevents accidental use of these routines,
which may permanently damage an instrument if used improperly.
The default setting is No. This setting should only be changed by
experienced users.

CFH lab version

This program may also be used to control a laboratory version of the

controls: CFH. These advanced features are not documented and cannot be
used in a flight instrument. The default setting is No.
2.4.3 Using Exit (CTRL-x)

The program must be closed using the Exit function. With this function the checkout
session will be properly logged. The program will log the last settings of all
instruments that have been checked out as part of the CFH.setup session. It will log

DOC-0386 Rev B
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these settings in the file CFH.SETUP.LOG in the data directory of CFH.setup (see
section 2.6.1).

After the program has ended, the CFH may be powered off and disconnected.

2.5 Routine operations

Two routine operations may be selected:

Operation Result

Tools->Monitor Output (CTRL-SHIFT-?) Monitor the CFH operation

Tools->Set Optics (CTRL-s) Clean the mirror and set the optical
detector

These two operations are used in normal operation to clean the mirror, set the mirror
reflectivity and monitor the normal operation of the CFH. For version 2L only: If more
than one instrument is being checked out in session, then CTRL-n (or Tools->New
Instrument) must be selected after connecting another instrument to reestablish the
connection.

2.5.1 Using Monitor Output (CTRL-SHIFT-?)

Monitor Output is used to watch the normal operation of the CFH. It will open a new
window that displays graphs for the current operation of the CFH. The data will also
be displayed as ASCII text in the status window and will be logged in the log directory.

DOC-0386 Rev B 12
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Figure 4: CFH.setup Monitor Output Window

The first graph shows the current mirror temperature. Shortly after the instrument has
been turned on, or a serial port reset has been issued, the mirror temperature will rise
by several degrees and then return to room temperature, which may be observed on

this graph.

The second graph shows the current detector signal. If this value is below 2.5V, then
the mirror heater will turn on, and the mirror temperature will increase. If cryogen is
not being used, then the optics settings routine (see below) must be used to clean and

readjust the optics.

The third graph shows the optics temperature. The lowest value that can be measured
is about 28 deg C. After a minute or two, this temperature will stabilize at around 34
deg C. The temperature may drift slowly upward after this. The color coding of the
numeric display to the right of the graph indicates whether the optics temperature is

within expected limits.

The fourth graph shows the amount of heat going into the mirror heater. If no cryogen
is used, then this graph should show 0 except for a short pulse after turn on. To stop
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this routine, click on the DONE button at the bottom of the screen. This window must
be closed before the CFH is unplugged or disconnected.

About a second after the CFH has been powered or the serial port has been reset, the
instrument will generate a short heat pulse to the mirror heater, which can be
monitored if the data output has been turned on after the first sign of life.

Note: The optics temperature should stabilize around 34°C. In most lab situations,
however, the optics temperature will slowly increase after reaching 34°C and may
exceed 45°C. Therefore EN-SCI recommends using a cooling fan if the instrument is
being run in laboratory conditions for extended periods.

The CFH control OP Amp Gain allows the user to change the gain factor of the first
operational amplifier stage in the CFH detector. This gain change is compensated for in
the CFH code. No significant change in the output should be noticeable except a
reduction in the output noise. This function is used for testing only and has no relevance
in routine operations.

2.5.2 Mirror Cleaning and Setting the Reflectivity (CTRL-s)

Set Optics (CTRL-s) is used to monitor the progress of the mirror cleaning and to
adjust the mirror reflectivity set point. Cleaning supplies (cotton swabs and methanol)
and the setscrew driver are needed to work with the CFH.

This routine places the CFH into the Set Optics mode. It displays four different graphs,
which differ from those displayed in the Monitor Output routine:

Detector signal with reference LED off
Detector signal with reference LED on
Reflectivity setting (%)

Optics temperature

A WN =
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Figure 5: CFH.setup Set Optics Window

Each graph also shows the numerical value of the current reading on the right side of
the graph. The temperature is color coded to indicate whether it is within the
acceptable range for setting the optics.

To clean the mirror most efficiently, perform the following steps:

1. Adjust the setscrew (see Figure 1) such that the reflectivity measurement
shown in the third graphs is within the visible range, i.e. near 88%. Do not
remove the screwdriver. It will be needed again in the next step.

2. Clean the mirror using a clean cotton swab and methanol. The cotton swab
should be moved across the mirror in only one direction. Doing so will move
residue off the mirror, instead of spreading it across the mirror. The
reflectivity value should be continuously watched to monitor the progress of
this procedure. The mirror is being cleaned as long as the mirror reflectivity
measurement is being decreased. If cleaning moves the data out of graphical
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range, then readjust the setscrew to bring the data back into the range of the
graph.

3. Repeat step 2 until the reflectivity measurement can no longer be decreased
by cleaning the mirror. If the reflectivity measurement is being increased, then
residue has been added to the mirror, which needs to be removed. This
measurement is extremely sensitive, and you may require some practice to
quickly and efficiently clean the mirror.

4. Once the mirror has been cleaned, i.e. the reflectivity measurement can no
longer be lowered using the cotton swabs, then turn the set screw until the
reflectivity measurement is within 88+0.1%. The screw has been set using
Loctite and may be difficult to turn. If this is the case, then values between
85% and 90% are acceptable parameters. However, make note of this condition
and add it to the meta-data for the current sounding.

5. After the optics has been properly set, this routine has to be terminated by
hitting ‘DONE’.

The lens should be cleaned only by blowing off any dust that may have collected.
Do NOT clean the lens with methanol. This will remove the anti-fog coating that
has been applied to the lens.

During the setting of the reflectivity, the optics temperature should be between
34°C and 39°C. The proper range is indicated by the green color next to the graph.

2.6 Files Created by CFH.setup

CFH.setup creates several log files, which record the activity of some of the
operations. The setup log file may be used to retrieve the settings of previously used
instruments.

26.1 CFH.SETUP.LOG

Upon program exit, CFH.setup logs all relevant parameters of each instrument that
was checked out as part of the CFH.setup session. The following parameters will be
logged:

CFH serial number

Thermistor calibration constants (4 constants)
CFH Specular voltage

CFH Detector voltage

Mirror reflectivity (in %)

Detector temperature at which the optics was set
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AD630 offset voltage
CFH firmware version
0 (not used)

Date of last set

Time of last set

Note that the detector setting refers to the values stored in the flash memory of the
CFH at the time of the last mirror cleaning and reflectivity setting operation. It may
not reflect the current setting, if the optics has become dirty or misaligned.

The date and time of each line refers to the last time the flash memory of the CFH
was read, not when it was written.

2.6.2 Monitor.loop.log

The CFH output of the monitor output operation (section 2.5.1) is logged in a file. This
file’s name will have the format 1Lxxxx.yyyymmdd.monitor.loop.log, where

xxxx = CFH serial number (Note that all files use 1L as prefix, even though the
instrument version is 2L)

yyyy = Year
mm = Month
dd = Day

Thus all sessions on the same day will be stored in the same file. Data from each
operation will be appended to the file, and no indication is given in the file of when
the operation was run. The file contains the data stream coming from the CFH, which
includes the following data:

Mirror temperature (in °C)
Detector voltage

Detector temperature (in °C)
Mirror heater duty cycle (in %)

2.6.3 Optics.setting.log

The CFH output of the set optics operation (section 2.5.2) is logged in a file. The name
of this file has the format 1Lxxxx.yyyymmdd.optics.setting.log, where

xxxx = CFH serial number (Note that all files use 1L as prefix even though the
instrument version is 2L)

vyyy = Year
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mm = Month
dd = Day

Thus all sessions on the same day will be stored in the same file. Data from each
operation will be appended to the file, and no indication is given in the file of when
the operation was run.

The data contained in this file are the data stream coming from the CFH and contain
the following data:

Specular voltage with reference LED turned off
Detector voltage with reference LED turned on
Mirror reflectivity (in %)

Detector temperature (in °C)

2.6.4 Lab Run Log

The CFH output of the monitor output operation (section 2.5.1) is also logged in a file
of the format lab.run.yyyymmdd.log, where

yyyy = Year
mm = Month
dd = Day

All sessions on the same day will be stored in the same file. Data from each operation
will be appended to the file. In contrast to the monitor output log file (section 2.7.2),
this file also contains a date and time stamp for each data line. In addition it contains
an additional column for the reading from a pressure sensor, which may be connected
to the laboratory version of the CFH.

3.0 Strato

Strato decodes the telemetry data, calculates physical parameters sent to the ground
station and analyzes the entire sounding. Strato can handle a multitude of instruments
and interfaces. It keeps track of all necessary meta data and is highly fault tolerant.

Note: The STRATO software will only recognize modem input from the radiosonde
receiver on COM ports 1 and 2. Please check the COM port for the modem and reassign
to 1 or 2 if it is a higher number.
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3.1 Strato Sounding Startup

During startup, Strato will ask for all relevant meta data to properly describe a
sounding. Complete the step-by-step questionnaire before beginning data recording. If
a value is entered incorrectly, it cannot immediately be corrected. However, at the
end of the questionnaire, a confirmation for all values is requested. If this is answered
negatively, then the questionnaire starts at the beginning; however, all entries already
made will be remembered.

3.1.1 Sounding-specific Questions

Strato requests the following sounding information from the user prior to data
recording:

Question/Request Description

Read data from serial port or | Specifies whether data are recorded and processed using a

file (S/F) serial input port or reprocessed from a raw data file.

Input Flight Name The standard flight name xxnnn contains two letters and
three digits, using a code for the flight location as the first
two letters.

For stations known to Strato (see Appendix C), no further
location information is asked. For other stations, the system
asks about latitude, longitude and launch elevation.

Enter Flight Date (DD-MM- The date of flight from the description file. This field is
YYYY) requested only during flight reprocessing for reconfirmation.
Enter launch elevation (m) The launch elevation is required to calculate the balloon

altitude over sea level. This field is only asked if a non-
standard flight code is used.

Enter location of flight The location is stored in the description file and used in the
graphics files.

Enter longitude of launch The longitude of the launch site is required to calculate the

site solar angle during the flight. This information enters the

radiation correction for the temperature measurement.
Enter latitude of launch site | The latitude of the launch site is required to calculate the
solar angle during the flight. This information enters the
radiation correction for the temperature measurement.
Enter WMO station number The WMO station ID can be entered here.

of launch site This must correspond to the station ID that is registered at
WMO.
Time zone The time zone relative to UT used in the computer to record

the data. The time stamp in the raw data file is read from
the computer clock, which can be set to GMT or local time.
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West of Greenwich the time zones are negative, east the
time zones are positive.

Enter surface pressure (hPa)

Enter surface temperature
(deg C)

Enter surface humidity (%)

The surface conditions are only asked during reprocessing to
keep track of them. They are not used in the processing
routines.

Enter instrument type

Specifies the configuration of the balloon payload.

e Ozone sonde only = 1

e Water vapor sonde only = 2

e Water vapor and ozone sonde = 3
This entry determines the subsequent instrument-specific
questions.

3.1.2

Hygrometer-specific Questions

Strato requests the following information about the hygrometer prior to data

recording:

Hygrometer number

The serial number of the frost point instrument. CFH sondes
must have the serial number preceded by 2L, e.g. 2L0215.

CFH detector signal (V)

The detector signal that was measured after mirror leaning,
corresponding to the same field in cfh.setup.

Specular (V)

The specular voltage signal that was measured during mirror
cleaning, corresponding to the same field in cfh.setup. It
refers to the higher voltage representing the clear mirror
signal without reference. After this value and the CFH
detector signal (V) value have been entered, Strato will
calculate the reflectivity value, which should agree with the
reflectivity value shown by cfh.setup.

AD630 offset (V)

The AD630 offset correction that was measured in
production, corresponding to the same field in cfh.setup.

3.1.3 Ozonesonde-specific Questions

Strato requests the following information about the ozonesonde prior to data

recording:

Ozone sonde number

The ozone sonde serial number. If the pump was individually
calibrated, the number must match the serial number in the
file PUMP.DAT.

Ozone flow rate time

The time to pump 100 cc measured during checkout.
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Lab temperature for flow
rate measurement

The temperature of the lab at the time of the flow rate
measurement. Lab humidity for flow rate measurement: The
humidity of the lab at the time of the flow rate
measurement.

Measured flow rate
correction (%)

The flow rate correction factor between lab and
moist air.

Response time from 4 to 1.5
HA (sec)

Time for the drop in ozone current from 4 to 1.5 pA after the
ozone exposure during checkout.

Prep background #1(pA)

The ozone background current before ozone conditioning.

Ozone background (hex)

The background (in hex) used for the sounding data analysis
in Tmax interface ozone sondes.

Ozone background (ua)

The background (in microamps) used for the sounding data
analysis in V2D and V7 interface sondes.

3.14

Radiosonde-specific Questions

Strato requests the following information about the radiosonde before data recording:

Vaisala serial number

Serial number for Vaisala radiosondes in flight recording
mode. It must correspond to the existing Vaisala RS80
calibration file. Wrong entries will lead to the use of a wrong
calibration file. If the proper calibration file cannot be
found, Strato will not proceed.

Intermet serial number

Serial number for Intermet radiosondes. The correct serial

number should be entered. This number does not refer to a
calibration file, however, and an incorrect number will only
lead to incorrect meta data, not to an incorrect calibration.

3.1.5

Confirmation of Correct Values

After the above information has been entered, Strato will query the user as to

whether the values are correct. If any value above was entered incorrectly, answering
no will return to the beginning of the input questionnaire. All entries are remembered
and only need to be confirmed using enter. Any incorrect value can now be corrected.

3.2 Data Recording

In flight recording mode, Strato will start recording all data coming in through the
serial port after the input questionnaire has been confirmed. (Refer to section 3.5.1
for information on the files being generated.) Incoming binary data are being
displayed in ASCII coded binary at the bottom of the screen to indicate that data are
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being received. If valid data packets are being recognized, then Strato will decode
these packets and display the data in real time.

Strato will detect a balloon launch automatically. The data before balloon launch may
be saved in the pre-launch data file, if this has been configured (see section 3.9). Data
after launch are always saved in the flight data file xxnnnFLT.DAT. Through this
separation, profile data are clearly separated from the pre-launch data. The last few
lines of the pre-launch data file contain the first few lines after the launch to provide
some overlap between both data files.

The first data line of a flight profile does not contain the instantaneous data line of
the moment of launch, but rather the average values of the 30 seconds to 1 min
preceding launch. This has been done to avoid spikes and spurious data occurring at
the moment of release.

3.2.1 Receiving No Data

If during flight recording no data are received for more than 30 sec STRATO will
repeatedly try to connect. This indicates a problem with the telemetry system that
has to be fixed immediately, and data are being lost.

During preflight recording, STRATO will record all incoming data, but will not complain
if no data are received. The program does not need to be interrupted if the
transmitter or the receiver is turned off; however, turning off the modem while the
receiver or transmitter are off reduces the amount of useless noise being recorded in
the raw data file.

3.3 Program Control

During reprocessing and data recording, you can control the data display using the
function keys and several selected letters on the alphabetic keyboard. See sections
3.3.1. In addition, the program start-up configuration can be modified to allow batch
processing and a quick start. The input questionnaire can also be skipped if all input
parameters are known to be correct.

3.3.1 Function Key Commands

Esc or F1 Stop Stop the program

F2 SumOFF | Turn off display of processed data (reprocessing only). This allows
faster reprocessing.
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F3 ClrScr Clear the screen. This is only necessary to erase message lines or
clean up the display.

F4 Graph Shows next available graph on screen depending on the instrument.

F5 N/A Not used.

Fé Info Display all input parameters.

F7 Units Toggles between display of Vaisala humidity or Vaisala frost-point,
and between metric and American units

F8 GPS / Switch display between GPS data, PTU sonde data, and Cobald data,

Cobald / | depending on the data stream available. The appropriate label will
Sonde appear automatically, once a new data stream has been recognized.

F9 BackGr During the prelaunch recording, a new ozone background can be

(Before entered. The current ozone channel value (in hex) is offered as a

Launch) default if it is a reasonable background.

F9 GetAlt Adjust the altitude according to the pressure using a standard

(After atmosphere. This is only useful if a pressure glitch invalidated the

Launch) altitude integration or after restarting the program during flight
recording.

F10 Surface Enter surface conditions during the pre-launch data recording.

F11 ResPor Reset serial input port. This can be used to change the settings of
the serial port.

F12 Configure | Configure the analysis settings of STRATO. This key is active only in
the initial questionnaire, and only after the flight name has been
entered. It cannot be used once the data are being processed or
received. See section 3.7 for details.

3.3.2 Letter Commands

f Flowrate Allows user to enter the ozone sonde flow rate during the initial
sonde preparation.

hor? | Help Display a simple help screen

( Launch Force a launch detection if the program had to be restarted
during descent or accelerate the in flight data decoding after a
system crash. Most likely using this key will require reprocessing
of the entire sounding.

n Next Switches forward to the next available graph. Same as F4.

o} Toggle sonde Toggle the processing of the primary and secondary ozone
sonde in dual sonde launches. This will mess up the data files that
are produced and will require consistent reprocessing.

r ResGraph Reset the prelaunch graph in case it gets too crowded.

s Surface Enter the surface conditions during the prelaunch sequence.
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w Wait Toggle whether or not the program waits at launch detect to view
the prelaunch graphs. This can only be used in reprocessing to
view the conditions at the moment of launch detection. If this
selection has been configured, then processing will resume after
any key has been hit.

3.3.3 Quick Start

If the program has to be restarted during flight recording, type <STRATO flightname>.
STRATO will assume all the previously used parameters and enter the recording mode
without asking any questions. Alternatively, typing <CTRL> <ENTER> during the start-
up questionnaire will skip all following questions and assume the default values
defined in the description file. Graphing is disabled if this feature is used.

3.3.4 Ending the program

In flight recording mode, the program will continue to collect data until it is
terminated by the user. To end the program, use function key F1 or ESC. Both keys are
equivalent. A confirmation question will be asked to avoid accidental termination. If a
launch has been detected, then the user will be asked to back up data (see section
3.3.6).

In reprocessing mode, the program will run until the complete raw data file has been
processed. Before termination, the user has the option to scroll through the different
data displays using function key F4. Hitting any other key will terminate the program.
Reprocessing may also be interrupted using function key F1 or ESC. However, any
output files will be incomplete.

In batch re-processing (see section 3.3.5) Strato will run until the last flight has been
processed and then terminate.

3.3.5 Batch Processing

The same quick start can be used to reprocess a flight. The field Input Port in the .INI
file will determine whether STRATO enters the reprocessing more or the recording
mode. STRATO can also process multiple flights with a single call, if flightname in the
DOS command line contains wildcard characters. If you wish to change some
parameter during the reprocessing, you can do so by entering the revised data as
prompted. You might also want to hit the “F12” key, which will allow you to enter
pressure offsets, select the cathode solution type, and select the pressure sensitivity
during the reprocessing process.
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3.3.6 Backup

STRATO will prompt the user for a USB drive letter after a flight recording is
completed. Simply type the drive letter.

The raw data file with the extension .RAW will be copied onto this disk as well as the
description file (.DE1), the data files (.DAT), the message file (.MES) and the Vaisala
file (.CAL). Thus the user is forced to create an immediate backup disk for the
sounding. If you skip the backup at the end of the program, make sure to copy the
files to a backup disk immediately after flight.

3.4 Ozonesonde Processing

ECC ozone sondes are processed using the equation:
Poz=ceTetioey s (I-Ty

where

Posis in [mPa]

| in [pA] is the measured cell current

Ibg is taken as the background current generated by the cell in the absence of
ozone

c = 4.309 « 10-4is the ratio of ideal gas constant R, and Faraday constant F
divided by the yield ratio x = 2 electrons per ozone molecule

T in [K] is the air temperature entering the cell, approximated by the
temperature of the pump

tiooin [s] is the flow rate time to pump 100 ml

y is the pressure dependent pump efficiency, which corrects the reduced pump
efficiency at low pressure

3.4.1 Background Current for ECC Sondes

3.4.1.1 Recommended Method for Handling Background Current

EN-SCI recommends customers do not use the background current feature of Strato.
(See discussion below for rationale.) Rather, EN-SCI recommends using a fixed number
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for all soundings. This will remove any artificial variability introduced by the operator
and insufficient filters. A background current of 0.015 pA appears sufficient.

This background current may be entered by pressing F9, or it may be entered in the
initial questionnaire during reprocessing. EN-SCI recommends continuing with the
traditional operation and keeping track of the background current readings measured
in the traditional way; however, EN-SCI does not recommend using these readings in
processing.

3.4.1.2 Research on Background Current

Historically the background current Ing has been treated in two different ways.'
Initially the background current was assumed to be pressure dependent. Thus the
background was assumed to decay as a function of decreasing pressure. This option
has not been implemented in Strato and is considered obsolete. Based on later work,
the background current was assumed to be a constant value, which is subtracted from
the measured cell current in data processing. Strato implements this option and offers
some assistance in measuring this current during the pre-launch procedures, as
described below.

Initially the background current is set to zero. During the pre-launch preparation of
the ECC ozone sonde, it is exposed to ozone-free air. Assuming that after sufficient
time the cell current stabilizes to a constant value, this reading can be used as the
cell background. If the sonde is connected to ozone-free air and the current has
decayed sufficiently, pressing F9 will provide an option to take the current reading as
background value. If confirmed, the background current will be set to the current
reading and will be subtracted from all future readings. Pressing F9 again will again
give the user the option to use the current reading as new background current.

Using a background current, negative ozone readings are possible if the confirmed
background current is larger than the actual reading. In this case Strato will report
9999 as value.

Recent work has indicated that the background current obtained in this way may be
inappropriate altogether. In particular, using insufficient ozone filters may lead to
background readings that are too high, leading to artificially low ozone readings. This
is the rationale for the current recommendation to use a fixed number for all
soundings.

1 See section 5.0 for references.

DOC-0386 Rev B 26
© 2016 JH ACQUISITIONS LLC DBA EN-SCI



Operator Manual, Cryogenic Frostpoint Hygrometer Sonde

3.4.2 Pump Efficiency Correction

The pump efficiency correction is controlled through the use of a file, which contains
individual pump efficiency corrections as well as different default pump efficiency
corrections. This file is named PUMP.DAT and offers several options for using different
pump efficiency corrections. The hierarchy of pump efficiency parameters is described
below.

1) If no PUMP.DAT file is present, then Strato will use a default pump efficiency
correction. This default resembles the pump efficiency correction called
“5ANOAA” published by Johnson et al. (2002). To indicate this choice, Strato
will log “Actually used coefficients = Strato default.”

2) If PUMP.DAT is present, then STRATO will search for the ECC pump number
within this file. If it is found, then the individual pump efficiency parameters
will be used to calculate the pressure-dependent pump efficiency factor. Strato
will not make any further log and will give the measured pump efficiency
coefficients that were taken from PUMP.DAT.

3) If PUMP.DAT exists but Strato does not find the individual ECC pump number in
the file, the program will search within this file for the default pump efficiency
correction configured in the runtime configuration. If Strato locates this entry,
it will use this specific default pump efficiency correction. To indicate this
choice, Strato will log the default coefficients set that was used as
“Coefficients = 1ZAVG.”

4) If PUMP.DAT exists but does not contain either the individual pump efficiency
correction or a default correction, Strato will revert to its internal default
values. To indicate this choice, Strato will log “Actually used coefficients =
Strato default.” The description file shows which pump efficiency correction
has been used and shows the correction factors at select pressure levels.

Great care should be taken in choosing the appropriate pump efficiency correction to
match the solutions used in the sonde.

3.4.3 PUMP.DAT Default Settings

PUMP.DAT contains several different default pump efficiency corrections that can be
configured within Strato. The correction factors are listed in Figure 7. See Figure 6 for
the Strato default correction.

The default pump efficiency corrections are based on different studies and are
grouped into two different families. The default correction built by Strato is nearly
identical with the 1ZAVG default correction. Strato will do a least squares fit through
the log of these pressure levels and interpolate along this fit. In the description file,
Strato records the pressure levels being used in the fit and the quality of the fit. At

DOC-0386 Rev B 27
© 2016 JH ACQUISITIONS LLC DBA EN-SCI



Operator Manual, Cryogenic Frostpoint Hygrometer Sonde

the bottom of this file, Strato also records the difference between the measured and

fitted values.

1.3

1.25 -

1.2 5

1.15 %

Correction Factor

1.1 4

1.05 -

A BAAVG
& 1ZAVG
& SAAVG
SATEMT
& SAMOAA
+ ZLR
— Strato default correction

1000

Fressure !
Figure 6: Graph of Pump Efficiency Correction Factors
Pressure

100 hpA 50 hPa 30 hPa 20 hPa 10 hPa 7 hPa 5 hPa
5 6AAVG 1.031 1.052 1.071 1.091 1.156 1.211 1.273
g 1ZAVG 1.0259 1.0427 1.0586 1.0775 1.1368 1.1891 1.2523
ué 5AAVG 1.0245 1.0373 1.0514 1.0687 1.1287 1.179 1.2435
T | SGATBMT 1.01 1.018 1.027 1.037 1.065 1.089 1.125
% 5ANOAA 1.011 1.015 1.022 1.032 1.055 1.0735 1.092
O | ZIR 1.01 1.015 1.024 1.033 1.054 1.068 1.087

Figure 7: Tabular Data for Pump Efficiency Correction Factors

3.4.4 Humidity Correction

During the initial questionnaire, STRATO asks for the Lab temperature for flow rate

measurement and for the Lab humidity for flow rate measurement. These values are
just stored and allow a later correction for the systematic error in using bubble flow
meters for the flow rate measurement in dry conditions.
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In addition, STRATO also asks for the Measured flow rate correction (%). This refers to
a few select sites that have the capability of measuring the flow rate both under
ambient dry conditions and saturated conditions. The ratio of these two measurements
defines the flow rate correction. STRATO does not apply this correction, but keeps
track of this measurement.

3.5 Output Files

3.5.1 Sounding-specific Files

Sounding-specific files should consist of a two letter station code ‘xx’ and a three digit
serial sounding number ‘nnn’. The following files will then be generated:

xxnnn.RAW The raw data file created by STRATO in the recording mode. It is also
used as input for reprocessing of the flight data. Reprocessing may be
necessary if some parameters are found to be incorrect after the
sounding. This file will be stored in the raw data directory configured in
STRATO.INI.

xxnnn.DE1 The description file created by STRATO contains all meta data and
processing parameters used for a sounding. This file will be stored in
the raw data directory configured in STRATO.INI.

xxnnnFLT.DAT This file contains all decoded and calculated parameters as an ascii
table. A short header duplicates some information provided in the
description file. This file will be stored in the profile data directory
configured in STRATO.INI.

xxnnnGPS.DAT Decoded GPS flight data file. This file contains the system time, GPS
time, GPS position, calculated wind, and predicted landing location. A
short header duplicates some information provided in the description

file. This file is produced only when the payload is equipped with GPS.
This file will be stored in the profile data directory configured in

STRATO.INI.
xxnnnPRE.DAT This file contains all data before launch detection and is only generated
if the analyze prelaunch data option in STRATO.INI has been selected.
xxnnn.LOG This file may not be useful for the normal user. For the Tmax

interfaces, and the V2D interface, the file contains the decimal-
decoded values for all data channels as well as the Vaisala channels.
This information can be used for cleaning the raw data file. Invalid
values in the raw data file are indicated by a negative value in the .LOG
file. For the Intermet data stream, the file contains the recognized data
packets in ascii encoded binary. This data file is only generated if
Vaisala logging in STRATO.INI has been selected. It may be useful to
identify problems that relate to individual channels and cannot be
identified otherwise.
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xxnnnBAD.DAT

Data judged as bad data in processing may be written out into this file.
This file may be checked to test whether Strato rejects an unusual
number of valid data lines.

xxnnn.MES

This message file is generated during flight recording and contains most
keyboard activities as well as all error messages that may have occurred
during flight recording.

xxnnnSEC.DE1

Same as the regular description file, except it records data for the
secondary ozone sonde in dual ozone sonde launches.

xxnnnSEC.DAT

Same as the regular flight data FLT.DAT file, except that it contains the
ozone profile of the secondary ozone sonde.

xxnnnSEC.PRE

Same as the regular pre-launch data PRE.DAT file, except that it
contains the ozone profile of the secondary ozone sonde.

xxnnnSEC.LOG

Same as the regular LOG file, except that it contains the raw ozone
data of the secondary ozone sonde.

3.5.2 Strato-specific Files

Strato-specific output files are listed below.

STRATO.INI

The initialization file that contains all information about the site of the
balloon launches, information about the settings of the computer
system, and some analysis settings. (STRATO knows about some launch
sites, but of course not all.) The geographical information is important,
since it enters into the data analysis. For example, STRATO calculates
the position of the sun and corrects the temperatures for a radiation
error. If STRATO.INI is not present, default values are assumed, and
Strato enters the setup menu on the first run to generate this file. It
may be edited later for reprocessing or proper configuring. This file is
stored in the working directory.

STRATO.MES

A message file used during batch processing. All error messages and
other information during flight reprocessing is stored in this file. It can
be used to verify proper analysis of several flights in a single batch job.
It is only generated in batch processing.

STRATO.LOG

This file keeps track of all flights that have been processed using
STRATO. It is stored in the working directory.

3.6 Flight Path Tracking and Landing Prediction

For payloads that include a GPS signal, Strato will display the current GPS coordinates
as well as a predicted landing coordinates in the GPS display screen (use function key
F8 to change between display screens). The GPS location is the position information
transmitted by the radiosonde and includes some status information, which indicates
the quality of this position. If no satellite signals are received by the on-board GPS
receiver, then the position information is unreliable. If signals from five or more
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satellites are received, then the position can be considered reliable within the
accuracy of the GPS receiver.

3.6.1 Landing Prediction

The landing prediction is continuously updated. Strato bases this prediction on the
wind and balloon information measured up to the current location. The landing
prediction is calculated using a wind profile buffer, which may be initialized before
launch and which is continuously updated throughout the sounding. At burst, the wind
profile buffer has been completely filled with the wind profile that was just measured;
the wind profile initialization no longer matters. Before burst, the wind profile above
the current balloon altitude is the initialized wind profile.

Errors in the wind profile initialization will lead to errors in the landing prediction
during the ascent phase of a sounding. Wind-profile initialization errors will not impact
the accuracy of the landing prediction during the descent phase of a sounding,
however.

The wind profile buffer is initialized automatically when Strato is started. Strato will
search for the file RAWIN.DAT in its working directory (i.e., the directory where
Strato.exe is located). If this file is found, it is read and used as the wind profile
initialization. If this file is not found, then no initial wind profile is used and the wind
profile is assumed to be zero. The file RAWIN.DAT is the output of the balloon track
prediction calculated at the University of Wyoming at
http://weather.uwyo.edu/polar/balloon_traj.html.

The output of this calculation should be saved as html file or text file and must be
named RAWIN.DAT. The file RAWIN.DAT is read after the launch location has been
defined during the initial startup. Strato then displays a preliminary landing location
based on the balloon and parachute performance parameters configured in
STRATO.INI. The output line will have the following form:

Lat: 9.6967 Lon: -84.1260 D: 34km a: 183 zr: 33.0km dt: 161 min - rawin.dat
where

Lat: Latitude of predicted landing site

Lon: Longitude of predicted landing site

D: Distance to predicted landing site from launch location

a: Azimuth angle to predicted landing site from launch location (0 = due north)
zr: Altitude of wind profile initialization

dt: Estimated time to landing
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Strato also displays the name of the file RAWIN.DAT to confirm that this file has been
read properly.

EN-SCI recommends that after a successful sounding, users move or delete the file
RAWIN.DAT. Doing so avoids using an improper initialization during the next sounding.

3.6.2 Landing Prediction Configuration

The balloon and parachute parameters are configured through the runtime configuration
and stored in STRATO.INI (see section 3.7). The important parameters to configure are
listed in the table below.

Parameter Variables Influencing | Comments
this Parameter
Expected Balloon | e Balloon size A typical value is 5 m/s, but this varies
Ascent Rate e Total payload depending on launch operations. This parameter
e Amount of gas used | is only of importance before launch. After
to fill balloon launch, the current ascent rate is used and
extrapolated to the balloon ceiling.
Expected Ceiling Same as above Typical values are 34 km for 1500 gr balloons and
Altitude of 30 km for 1200 gr balloons.
Balloon
Expected Balloon | e Size of parachute Arate of ~5 m/s at landing is desired to minimize
Descent Rate at e Payload weight potential damage. Strato’s model has a descent
Landing rate of about 40 m/s at 35 km, which decreases
to the configured descent rate at landing.*

* On descent, the model is adjusted using the current descent rate, which is then
extrapolated to the configured descent rate at landing. The descent rate model can be
modified by selecting the option of a valved balloon. For a valved balloon, then
estimated descent rate at 35 km is only about 8 m/s. Otherwise, the descent rate model
behaves the same as for a regular balloon.

3.7 Strato configuration

3.7.1 Runtime Configuration (Function Key F12)

Strato can be configured at runtime during the initial questionnaire. After the flight
name has been entered, the configuration menu may be opened using the function key
F12.

DOC-0386 Rev B 32
© 2016 JH ACQUISITIONS LLC DBA EN-SCI



Operator Manual, Cryogenic Frostpoint Hygrometer Sonde

The up/down arrows maneuver through the menu and the left/right arrows on the
keyboard change the parameters.

The Enter key confirms all changes, while the Esc key cancels any changes made. All
settings except for the pressure offset will be stored in STRATO.INI (see section 3.7.2)

and will be used as default for Strato’s next session.

Config Parameter

Description

Analyze
Data

Prelaunch

Turns on analysis and saving of prelaunch data into
xxnnnPRE.DAT.

Screen Mode

Controls whether during telemetry Strato runs in window mode to
display text only or whether Strato runs in full screen mode, where it
will also display graphics. On Windows 7 machines the Graphics mode
will not run.

Create Average Files

Turns on layer average file calculation into xxnnn.LE1.

Pressure Verification

Specifies if the Vaisala pressure is verified through a high quality or
low quality filter. The higher filter is better in high noise situations;
however, it rejects more data and may not be suitable for Intermet
radiosondes.

Ignore Missing Data

Bad data lines can be written into the file xxnnnFLT.DAT or can
be ignored. If they are ignored they are written into
xxnnnBAD.DAT.

Wait at Launch
Detect

During reprocessing the program may wait at launch detect to allow a
look at the prelaunch graph.

A/D System

This parameter specifies the radiosonde interface used on the balloon.

Radiosonde Pressure
Offset

The radiosonde pressure offset is used to correct for pressure offsets
in the radiosonde. This item is not saved in STRATO.INI;however, it is
saved in the description file of the flight being processed.

Radiation Correction

For the Vaisala radiosonde, the radiation correction will always be
applied. For the Intermet radiosonde, the radiation correction may be
applied depending on this setting.

Pump Correction
Default

Refers to the default correction coefficients specified in the pump
correction file PUMP.DAT.

Solution

Specifies which cell solution is used. It is used for housekeeping only
and has no processing impact. This setting should be checked,
whenever a solution is changed.

Ozone Sonde

Specifies, whether the primary or the secondary ozone sonde is being
processed on a dual sonde flight using one V2D interface with
extension. The output file name indicates whether the file contains
the primary or secondary sonde data.

Computer Time

Specifies, whether the computer's system clock is running on local
time or on GMT. For each flight the time zone will be checked, which
is then used to calculate the proper GMT time.

Valved Balloon

Specifies, whether the landing site estimate is based on a valved
balloon or a balloon burst.
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Balloon Ceiling

Specifies the expected balloon ceiling and used in the landing site
estimate. Range is 15 to 35 km.

Ascent Rate

Specifies the expected average balloon ascent rate and used in the
landing site estimate. Range is 2.5 to 8 m/s.

Landing descent rate

Specifies the expected payload descent rate at landing and used in
the landing site estimate. Range is -1.5 to -17 m/s.

3.7.2 STRATO.INI configuration

The settings configured in the runtime configuration are stored in the file STRATO.INI.

This file contains several settings that cannot be configured through the runtime menu
(section 3.7.1) and need to be changed here. However, the user must take care when
working with this file, as it is generated automatically and poor editing may lose the
corresponding settings.

The explanations below provide a reference when the setting has been explained in
other sections of this document and can be set elsewhere in Strato.

3.7.2.1 Settings for Last Processing

Parameter and Sample Description Reference, if
Value applicable
Strato version = 9.28 Current Strato version 3.3.1

Input port = File

Specifies whether data are recorded and | 3.3.1
processed using a serial input port or
reprocessed from a raw data file

Flight name = BLOO1 Last flight name 3.3.1
Instrument type = 2 Last Instrument combination 3.3.1
Date = 6 July 2010 Last flight date 3.3.1
Time = 14:19:19 Last flight time 3.3.1

3.7.2.2 Settings for Site Description

Parameter and Sample Description Reference, if
Value applicable
Location = JPL-Table Last flight location 3.3.1
Mountain Facility,

Wrightwood, CA

Longitude = -117.7000 Last flight longitude 3.3.1
Latitude = 34.4000 Last flight latitude 3.3.1

WMO station number = Last flight WMO station number 3.3.1

78762
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Time zone = -7

Last flight time zone

3.3.1

Launch altitude = 2285

Last flight launch elevation

3.3.1

3.7.2.3

System Settings

/ 8 bit Tmax / V2C / IMet

interface used on the balloon GMT

Parameter and Sample Description Reference, if
Value applicable
Raw data directory = Location where raw data (.raw, .de1 and 3.2
C:\BALLOON\DATA\ .mes files) are stored
Profile data directory = Location where processed data (.dat and 3.2
C:\BALLOON\DATA\ .log files) are stored
Computer time = Local Local Specifies, whether the computer's 3.9.1

system clock is running on local time or on

GMT
A/D system = 12 bit Tmax | This parameter specifies the radiosonde 3.9.1

Serial port=1/2

Serial port, on which data are being read.
This can only be ‘1’ for COM1 or ‘2’ for
COM2.

Can be configured
only in Strato.ini

Baud rate = 300 / 1200

Baud rate at which data are being read.
This can only be ‘300’ for 12 bit Tmax, 8
bit Tmax and V2C or ‘1200’ for Imet.

Can be configured
only in Strato.ini

to alert the user. ON is recommended for
flight recording, but may be set to OFF for
reprocessing.

Parity = N Parity must be N for no parity

Data bits = 8 Must be 8 for 8 bits

Stop bits = 1 Must be 1 for 1 stop bit

Bell = On / Off Indicates whether the Beep sound is used Can be configured

only in Strato.ini

Screen = Graphics/Text

Controls whether during telemetry Strato
runs in window mode to display text only or
whether Strato runs in full screen mode,
where it will also display graphics.

3.9.1

3.7.2.4

Processing Settings

Parameter and Sample
Value

Description

Reference, if
applicable

O3 pump correction file =
PUMP.DAT

Name of the pump efficiency correction file
to be used. It is recommended that this file
name is maintained.

Can be configured
only in Strato.ini
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Background default [uA] =
0.000

A default ozone cell background current
may be

configured, which is being applied without
selecting a background current as part of
the prelaunch instrument check. A
prelaunch instrument check selection will
overwrite the setting used here.

Can be configured
only in Strato.ini

Background treatment =
Constant

Must be constant. A pressure-dependent
background correction is no longer used
within STRATO.

Can be configured
only in Strato.ini

/ Yes

correction will always be applied. For the
Intermet radiosonde, the radiation
correction may be applied depending on
this setting

Solution = 1%/ 0.5% / 2%, | Specifies which cell solution is used. It is 3.9.1
No Buffer / 1.5%, No used for housekeeping only and has no

Buffer / 1%, 1/10 Buffer | processing impact. This setting should be

/ other checked whenever a solution is changed

Radiation correction = No | For the Vaisala radiosonde, the radiation 3.9.1

GPS data on serial = No
/Yes

Specifies whether the current GPS location
and landing prediction are output on the
other serial port as NMEA data string at
9600 baud. Strato is only capable of using
COM1 or COM2. If data are being read on
COM1, then the GPS data are output on
COM2 and vice versa.

Can be configured
only in Strato.ini

iMet xdata on serial = No
/Yes

Specifies whether the current Imet are
output on the other serial port as xdata
data string at 9600 baud. If data are being
read on COM1, then the xdata are output
on COM2 and vice versa. Strato is only
capable of using COM1 or COM2. If both GPS
and XDATA are output, then both

will be output on the same serial port.

Can be configured
only in Strato.ini

iMet time out interval =
10

IMet data packets arrive at different times
and fill up the data line buffer as they
come in. If due to poor data reception
quality data packets are missed, then the
buffer may be set to bad data after a
certain time. This setting specifies after
which time (in seconds) the buffer is being
set to bad data, which will appear as such
in the flt.dat file. Using a longer time will
reduce the amount of bad data simply by
duplicating the last received good data
packet. Using a shorter time will reduce
data repetition and increase the amount of
bad data. Using 10 seconds corresponds to
roughly 50 m vertically of data buffering.
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3.7.2.5

Analysis Settings

Parameter and Sample

Description

Reference, if

Low checking

through a high quality or low quality filter

Value applicable
Default coefficients = Refers to the default correction coefficients | 3.9.1
1ZAVG / 6AAVG / 5AAVG | specified in the pump correction file

/ 5ATBMT / 5ANOAA / PUMP.DAT

ZLR

Vaisala logging = Yes/No | Turns on channel decoding into xxnnn.LOG 3.9.1
Analyze prelaunch data = | Turns on analysis and saving of prelaunch 3.9.1
Yes/No data into xxnnnPRE.DAT

Create average files = Turns on layer average file calculation into | 3.9.1
Yes/No xxnnn.LE1.Summary averaging [km] = 0.25
Pressure verification = Specifies if the Vaisala pressure is verified 3.9.1

Ignore launch = Yes / No

May be used to turn off launch detection. If
this setting is turned off, then all data are
recorded in the pre.dat file and the
altitude is calculated from the beginning of
the recording. This allows using extended
ground checks, launching sondes on
tethered sondes or other vehicles, without
being interrupted by a launch detection.

Can be configured
only in Strato.ini

Launch detection scheme
=1

Internal use only. Should be set to 1.

Can be configured
only in Strato.ini

Ignore missing data =
Yes/No

Bad data lines can be written into the file
xxnnnFLT.DAT or can be ignored.

3.9.1

rate at landing and used in the landing site
estimate. Range is -1.5 to -17 m/s.

Wait at launch detect = During reprocessing the program may wait 3.9.1
Yes/No at launch detect to allow a look at the
prelaunch graph.
Valved balloon = Yes/No | Specifies whether the landing site estimate | 3.9.1
is based on a valved balloon or a balloon
burst.
Profile ceiling = 30 +/- 1 | Specifies the expected balloon ceiling and 3.9.1
used in the landing site estimate. Range is
15 to 35 km Landing site elevation = 0.075.
Profile rise rate = 5 +/- Specifies the expected average balloon 3.9.1
0.5 ascent rate and used in the landing site
estimate. Range is 2.5 to 8 m/s.
Landing descent rate = -5 | Specifies the expected payload descent 3.9.1
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4.0 CFH Flight Preparation

4.1 Instrument Check

Before a CFH instrument can be used, it should first be checked using the computer
interface. See section 2.2 for details how to connect the CFH to the computer. Start
CFH setup and make sure all connections and settings are correct. When the CFH is
powered on, CFH.setup will show the last saved settings of the CFH. If these settings do
not appear, check the connection and configuration of the serial port in the computer
and in the properties of CFH.setup.

After successfully powering on the CFH, check the basic operation of the CFH by using
the Monitor Output routine. The mirror temperature should show roughly room
temperature (unless the CFH has recently experienced a large temperature change such
as bringing it in from a cold storage room). The optics temperature should start warming
up. Note that the optics temperature will not show values of less than 28°C. The
detector voltage should show a value similar to the detector voltage stored in the last
setting. If the detector voltage is less than 2.5V, then the mirror heater will turn on and
immediate action should be taken. Immediate action means either disconnecting the
CFH or starting the Set Optics routine.

After verifying the proper operation of the CFH, the mirror should be cleaned and the
mirror reflectivity should be set. See section 2.5.2 for a detailed explanation of this
procedure. Once the reflectivity has been properly set, the detector voltage should
show a value larger than 2.6V.

After an instrument has been properly set, all fields in the status window of CFH.setup
should be white. Fields that are marked in red on the display indicate that proper
monitoring of that parameter is required:

Field Comments

CFH instrument A red field indicates missing calibration coefficients. An instrument
without calibration will not report a proper mirror temperature.
Make sure that the number in the field agrees with the serial
number following the letter ‘L’ written on the instrument box.
Then reload the calibration coefficients (see section Error!
Reference source not found.).

Set point A red field indicates that the setting is outside of the recommended
range of 88.0% + 0.1%. If the mirror is clean, then simply rerun the
Set Optics routine and turn the setscrew to achieve the appropriate

value.
Detector Signal A red field indicates a weak optics signal. This cannot be changed
by the user.
Specular A red field indicates a weak optics signal. This cannot be changed
by the user.
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Set point A red field indicates that the Set Optics routine was finished, when
temperature the optics temperature was outside the nominal range of 34°C to 39
°C. Bring the detector into the proper temperature range and rerun
the Set Optics routine.

AD630 offset A red field indicates that the AD630 offset parameter is outside the
expected range. Make sure that all connections are proper and
rerun the Measure AD630 offset routine.

Code version A red field indicates that a CFH has not yet been connected to
CFH.setup or that a CFH has not been recognized.

4.2 Telemetry Check

A full telemetry check tests the proper functioning of all components of the payload.
Great care should be taken to verify that all signals are properly received. To avoid
problems, the following steps should be followed closely.

When turning on instruments, it is important that with every power on step, the
telemetry is being checked that the appropriate response happens. If such checking does
not occur, the complexity of the system may confuse otherwise obvious issues.

The following procedure applies to version 2L of the instrument.

1. Start up the radio receiver and decoding software. Make sure that all connections
and configurations are appropriate.

2. Start STRATO and make sure that all values have been properly entered. Without
the data transmitter running, Strato should show rows of meaningless data
running at the bottom of the screen. No data should be decoded and no data
should be shown in the data section on the left. If no binary data are running at
the bottom of the screen, then check the radio and the connection between the
radio receiver and Strato.

3. Power on the Intermet radiosonde. The Intermet radiosonde will show a yellow
light next to the power switch for about 10 seconds indication the radiosonde
initialization. After this, the characteristic Intermet tone should audible and PTU
data should be properly decoded and displayed in Strato.

4. Check the pressure, temperature and humidity values and make sure that they
are reasonable for the environment the radiosonde is currently in. The altitude
displayed is that stored with the station code or the altitude that was entered
during the initial questionnaire. The rise rate may show any value due to noise
in the pressure sensor.

5. Within a second after telemetry has started, Strato will recognize the GPS unit
and display ‘Recognized GPS data. Press F8 to change data screens’. Strato will
show GPS above the F8 key field, which will allow switching to the GPS data
page. Press the F8 key to switch to the GPS data display. GPS data may not be
immediately available and incorrect data may be displayed. If the payload is
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outside and has a good view of the sky, GPS data should be received after about
a minute, depending on the received signal strength.

6. Start up the ozone sonde (if part of the system).

a. Within 2 seconds, Strato will display ‘Recognized ECC ozone sonde’.

b. The mixing ratio (03 mixing ratio) should be reasonable. Without filter,
the mixing ratio is typically between a few ppbv (4.00E-03 ppmv) to a few
ten ppbv (4.00E-02 ppmv).

c. The pump temperature (Pump Temp) should be between room
temperature and 35 deg C. If the pump has been running for an extended
period of time, it may exceed 40 C and should be turned off if a launch
is not imminent.

d. The pump current (Pump Current) should be less than 100 mA.

e. The ozone battery (O3 Batt) should be between 14 V and 18 V depending
on the battery type used. At a battery voltage of less than 13 V, when
using the nominal 18 V lithium batteries, the batteries should be changed.

7. Power the CFH (if part of the system).

a. Within 2 seconds, Strato will display ‘Recognized CFH sonde’.

b. The mirror temperature should change within 2 seconds from about
-140C to roughly room temperature. Within another 2 or 3 seconds, the
mirror temperature will increase strongly and then begin to decrease
slowly to room temperature. Make sure that this spike is observed, since
it is a vital instrument test.

c. After about 10 to 15 seconds, Strato will display ‘Detected CFH
calibration for sonde number’ followed by the serial number of the
instrument. The detector voltage should roughly equal the detector
voltage set during the CFH preparation. The deviations may be as large
as 0.02V, but should not be larger than that. Strato will display a message
if the received detector voltage is significantly different from the set
point detector voltage.

d. The optics temperature should start at 28 C and after a few minutes
should rise to about 35 C. The time for this increase depends on the
ambient temperature and is longer at cold environments.

8. Power the Cobald sonde (if part of the system). Within 2 seconds, Strato will
display ‘Recognized Cobald sonde number xx. Press F8 to change data screens’,
where xx is the serial number of the Cobald sonde. Switch to the Cobald data
screen using F8 and make sure that data are being received.

4.3 Payload Assembly

Assembling the payload requires connecting all cables and taping them to the foam box.
If the payload contains an ozone sonde, follow the ozone sonde instructions. Make sure
that the ozone sonde inlet tube is not taped to the foam box.
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The CFH battery sits in its own foam box, which is taped over the electronics of the
sensor. The battery box is attached using double-sided tape. Only the long sides of the
battery box are taped; see arrows in Figure 8. The protection covering the double-sided
tape on the short side remains in place and is not removed. This allows safer removal of
the battery box after recovery.

Figure 8: CFH Battery Pack

Before removing the protective cover of the long side double-sided tape, ensure the
following conditions are met:

e The battery box fits over the electronics without touching the electronics

e The battery cable(s) leave the battery box on the slotted side

e The power cable connecting the sensor electronics and the battery cable(s) is
taped to the CFH box
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Before closing the CFH battery box (and the ozone sonde box), check the telemetry and
make sure that all cable connections are working and that all signals are properly
received.

Close the CFH battery box by removing the protective cover on the long sides of the box
(Figure 8) and attach the battery box with the battery cable(s) being located on the
same side as the power cables leading to the electronics.

Secure the battery box by using a 2 cm (3/4” to 1”) wide tape and wrap it around the
entire CFH securing both sides of the battery box. When using an ozone sonde, close the
ozone sonde lid and secure it by wrapping tape around the entire box on both sides of
the lid.

Balance the payload and make sure that it hangs properly. Move the payload ring to
adjust the payload balance.

After finishing the payload installation, check the telemetry again to make sure that all
instruments are working properly and that all data are properly received through the
telemetry data stream.

The instrument may remain in this configuration for a day or two if launch delays are
encountered. The CFH does not need to be opened and checked for a week if it hangs
in a clean and secure location.
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Figure 9: CFH Battery Pack in Final Assembly

4.4 Inlet Tube Installation

The inlet tubes are essential parts to guarantee sampling of air that has not been
contaminated by outgassing of the instrument itself. The inlet tubes are designed to
collapse upon landing to avoid destroying the sensor. They must be installed prior to
launch after the instrument has been checked out and all telemetry tests have been
done successfully. Depending on the operational procedures, the inlet tubes may be
installed prior to balloon inflation or several hours to a day before launch if the
instrument does not need to be moved anymore.

The glue used to install the inlet tubes dries within 5 minutes, so good preparation and
swift installation are important. The glue has been selected to assure a good seal and a
secure bond while at the same time allowing the removal of the tubes from recovered
instruments.

The following steps are recommended for quick and secure installation of the inlet
tubes:

1. Verify that the inlet and outlet tube fit into the sensor before preparing the glue.
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2. Hang the payload to work comfortably.

3. Prepare a few strips of adhesive duct tape of roughly 20 cm in length. This tape
will be used to secure the lower tube while the glue is setting.

4. Open and mix the epoxy glue (follow the glue’s instructions).

Figure 10: Glue, Mixing Tubes and Inlet Spatula

Put a ring of epoxy (like an O-ring) around the edge of the inlet tube ring. Be careful to
leave some space between the epoxy and the edge of the inlet tube.

Figure 11: Applying Glue to the Inlet Tube Ring

Carefully place the upper tube into the CFH sensor. Make sure the tube has entered the
sensor and is vertical. No tape is needed to secure this tube.

Carefully place the lower tube into the CFH sensor. Before releasing the tube, use the
prepared strips of tape to fix its position.
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Check again that both tubes are properly inserted into the sensor housing. Make sure
that both tubes are vertical, although perfect vertical alignment is not crucial. A good
seal around between sensor and tubes is essential, however.

The glue sets within about five minutes. The instrument is flight ready once the glue
has hardened enough so that the tubes are fixed well to the sensor. Using additional
tape (Figure 12) helps secure the inlet tube while the glue is drying.

Figure 12: Installing the Lower Inlet Tube

4.5 Cryogen Preparation

The cryogenic liquid is extremely cold and must be handled using
protective clothing. Gloves, a long sleeved shirt and long pants are
required.

The CFH uses F23 as cryogenic liquid. Under room temperature, this substance is in
the gas phase and needs to be pre-cooled to be used. The boiling point at normal
pressure (1013 hPa) is -82.1°C. To pre-cool the cryogen, the cylinder may be stored

in dry ice for at least 2 hours or may be stored in an ultra-low temperature refrigerator
at -80°C.

Pre-cooling the cryogen using dry ice may be done in a specially insulated box or in a
large camping cooler box, to which some insulation has been added. In a well-insulated
box, about 7 kg are required to cool the cryogen cylinder and another 7 kg per day are
needed to maintain the cold temperature for an extended period of time. For short
campaigns, it is preferred to keep the cylinder cold for the entire campaign period. This
requires that the cylinder is replaced in the cold cryogen box immediately after taking
cryogen.

DOC-0386 Rev B 45
© 2016 JH ACQUISITIONS LLC DBA EN-SCI



Operator Manual, Cryogenic Frostpoint Hygrometer Sonde

For extended and regular use, it is preferred to cycle the cryogen cylinder, i.e. allow
the cylinder to warm up after a measurement. Make sure that the cylinder and the
cryogen box stay open so that they can properly dry out. In particular, make sure that
the valve assembly of the cryogen cylinder has the chance to dry out completely.

4.6 Filling the Cryogen

For a single sounding, 300 cc of cryogenic liquid are required. Using an insulated
measuring cup (e.g. coffee thermos) is preferred. The cryogen may also be filled directly
into the instrument.

The cryogen should be equipped with a dip type (siphon), which allows draining the
liquid from the bottom of the cylinder in an upright position. See Figure 13.

Figure 13: Filling the Cryogen Transfer Cup from a Cryogen Cylinder Equipped with a Dip Tube

If the cryogen cylinder does not have the dip tube installed, the entire cylinder has to
be turned upside down to drain the liquid cryogen. This procedure is potentially unsafe
and not recommended. When ordering cryogen, make sure that the cylinder comes with
a dip tube to avoid this potential issue.

Before filling the cryogen from the transfer cup into the instrument, the filling nozzle
needs to be removed from the cryogen cylinder and the cylinder should be returned to
its cold storage. This avoids unnecessary accumulation of ice inside the valve assembly.
When removing the filling nozzle, make sure not to bend the tube, since the plastic
material is fragile when cold. Before filling the cryogen into the CFH cryogen
compartment make sure that the CFH is running.
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Figure 14: Filling the CFH Cryogen Compartment with Cryogen

The CFH must be powered before the filling the instrument with
cryogen. Failing to do so will result in excessive ice build-up in the

sensor, which will require the launch to be aborted.
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Appendix A: Avoiding Serious Mistakes in
Handling the CFH

There are several mistakes that can severely impact the performance of the CFH. Some
of these mistakes may not be obvious to the novice user. Please read this section
carefully. These recommendations are based on numerous experiences should help avoid
unsuccessful soundings.

e The CFH must be powered before the cryogen is filled into the instrument.
Ideally, the CFH is being turned on at least a couple of minutes before the
cryogen is filled. If the CFH is not turned on, when the cryogen is being filled,
then large amounts of ice will form on the mirror. If the CFH is turned on under
this condition, the ice will melt, liquid will remain on the mirror and will collect
contaminants that ultimately impact the mirror. If this mistake occurs, the
cryogen has to be dumped and the instrument has to be given time to warm up.
Then the mirror has to be cleaned again and the optics has to be properly set.

e When the inlet tubes are glued into the instrument, the lower tube may slip out
despite the adhesive tape that is supposed to keep it in place. The glue may then
harden with the lower inlet tube being outside the sensor housing. In this case
descent measurements in the stratosphere and tropopause region are guaranteed
to be contaminated.

¢ |f you are using the dual battery pack with two connectors, always connect both
batteries—even for testing—to use them evenly. The CFH without cryogen can
run up to maybe 30 minutes on the ground for testing and check procedures
without a significant risk of losing battery life during the sounding. The CFH
batteries must be disconnected after the end of any testing, or else the battery
may run empty before launch.

o |f the CFH is prepared in an air conditioned lab at tropical sites, the CFH should
be brought outside well before balloon inflation to give the instrument the
opportunity to equilibrate. In particular the lens of the detector is likely to
collect water, which will impact the CFH performance. Equilibration avoids this
problem. The time for equilibration may be at least one hour or so. The CFH
should not be powered on during this time.

e The telemetry of all payload instruments must be verified before the cryogen is
filled. Make sure that all parameters are within the expected range. Interrupt
the balloon launch count-down, if serious or suspicious issues are detected. Make
sure any instrumental issues are addressed prior to proceeding. After cryogen
filling, the telemetry test should only verify the proper CFH operation. The
payload should be launched within 3-5 minutes after the cryogen filling. At the
surface the rate of cryogen usage is highest and extended delays will negatively
impact the working time of the cryogen in flight.
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Appendix B: CFH Communication Protocol

Communication with the CFH may occur through HyperTerminal alone. The protocol is
a RS232 serial communication. For version 2L (Intermet) has the following
communication protocol:

e 19200 baud e 1 stop bit
o 8 bit ¢ No handshaking
e No parity

The connection is through a USB cable, which requires the serial port drivers from
SiLabs. These drivers are included in the CFH.setup distribution and are found in

C:/Programs/cfh.setup/support/CP210x/
The drivers may be pre-installed by running
C:/Programs/cfh.setup/support/CP210x/ CP210x_Drivers.exe

The cable pin-out is shown below.

Pin Function
1 GND
2 Tx
3 Rx
4 GND
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Appendix C: Known Strato Locations

Note that elevation is given in meters.

Code |Station name Elevation Lon Lat| Time zone
AS South Pole 2835 169.00| -90.00 0
AZ Lajes, Azores 112 -28200 3820 0
BD Bandung 740 10760 690 7
BE Bermuda 5 -64.68 3737 -4
BI Biak, Indonesia 5 13606, -1.17 9
BL Boulder, CO 1743 -105.20, 3995 -7
CI Christmas Island 0 -157200 152 -10
CL Crows Landing 431 -12120, 3740 -8
CX Christmas Island 0 -157.20 1.52 -10
DA Darwin 0 15000 -12.00 -12
DN Da Nang 7 108.18| 16.03 7
EW  |Edwards AFB 743 -118.00f 35.00 -8
FB Fairbanks, AK 180,  -147.70, 6480 -9
FS Fort Sumner, NM 12491 -10430, 3450 -7
Fl Suva, Fiji ] 178.4| -18.13 12
HC Ho Chi Minh, Vietnam 9 10667, 1092 7
HI Hilo, Hawaii 11 -155.06, 1971 -10
HN Ha Noi, Vietnam 7 105.80f 21.01 7
HU Huntsville, AL 196 -86.64 3472 -5
IC Keflavik, Iceland 10 -23.00f 6397 0
IN Juazeiro do Norte, Brazil 412 -3928, 723 -3
KA Kaashidhoo Maldives 1 7346, 497 5
KR Kiruna 300 2109 6790 1
KS Kosan, Korea 70 126.17, 3328 9
LA Lauder, New Zealand 370 16968 -4504 12
LH Lhasa, Tibet 3650 91.1356/29.6584 8
LI Lindenberg, Germany 112 14,1202 /522093 2
LR La Reunion 24 5548 -21.06 4
LT Alert, NWT 66 -61.50 8200 -5
ME Merida, Venezuela 1570 =71.17 858 5
MM  |McMurdo 10, -16670 -77.81 12
NA Ny Alesund 15 1193 7892 1
OK ARM/CART SGP, Oklahoma 313 -9749| 3661 -6

DOC-0386 Rev B
© 2016 JH ACQUISITIONS LLC DBA EN-SCI

50



Operator Manual, Cryogenic Frostpoint Hygrometer Sonde

PA Paramaribo, Suriname 25 -5521, 581 -3
RI University of Rhode Island 21 -7142 4149 -5
SA Pago Pago, American Samoa 5 -17056| -1423 -11
SC San Cristobal, Ecuador 8 -8962 090 -6
SE Sapporo-EES 26 14135 4307 9
SI Sable Island 10 -60.03 4393 -5
SJ Heredia, Costa Rica 1176 -84.11,  10.00 -6
SO Sodankyld, Finland 179 2663| 67.367 2
SS SriSamrong, Thailand 20 9987 17.15 7
SY Syowa Station, Antarctica 11 3958 -69.00 3
TA Papete, Tahiti 2/ -14900 -18.00 -1
TH Trinidad Head, CA 35, -124.16, 41.08 -8
TR Tarawa, Kiribati 3 17292 1.35 12
TU Thule, Greenland 58 -69.00 7750 0
WA Watukosek, Indonesia 50 11260 -750 7
WK | Watukosek, Indonesia 50 11260, -750 7
WY  Laramie, WY 2217, -10540, 4120 -7
YJ Yangjiang, China 91 1119782 21.8455 8
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Appendix D: Equations

Altitude calculation

The altitude is calculated by integrating over the hypsometric equation. Numerically
this is implemented as:

P=,P-P
oP=P —P,
J
R =8.3145
mol-K

g =9.80665 =
.

Mdry = 28 966¢
M,,, =18015g

¢ = R 002027
M, g
M, -M,,
c2=—2 0 _(378064
M,
6P

d7=c(T+27315)— 2
! P—c,P

28 v

where

e P1 and P2 are the two pressure readings at the bottom and top of a layer
e T is the air temperature within this layer ambient temperature and
e Puyois the partial pressure of water within this layer

Vapor Pressure Equations

Saturation Vapor Pressure over Liquid Water

To be consistent with the vapor pressure equation used by Vaisala and with vapor
pressure equations in the CIMO guide, Strato uses the Hyland Wexler equation:

DOC-0386 Rev B 52
© 2016 JH ACQUISITIONS LLC DBA EN-SCI



Operator Manual, Cryogenic Frostpoint Hygrometer Sonde

Piposwaer = EXP(-0.58002206 10*/ T
+0.13914993 10}
~048640239 1071 T
+ 041764768 10° T°
-0.14452093 107 77
+0.65459673 10" Log(T))

with T in [K] and Przo,water in [Pa]

Saturation Vapor Pressure over Ice

For vapor pressure over ice, Strato uses the Goff Gratch equation:

Prosee = 10A(-9.09718 (273.16/T - 1)
~3.56654 Log10(273.16/ T)
+0.876793 (1 - T/ 273.16)
+ Log10(6.1071))

with T in [K] and P20 water in [hPa]

Appendix E: Troubleshooting

CFH.setup Issues

o The CFH does not send any message to CFH.setup when powered.
Solution:

Try any of the following:

e Select File>New Instrument (or CTLR-n) to reset the COM port and the CFH
e Check the COM port selection in the Properties menu

e Check the USB connection

e Check the power supply to the CFH

After the initial power up message, the CFH will not show any further indication of its
operation until a function has been selected.
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Strato Issues

o Strato crashes and shows a Window titled “16 Bit MS-DOS Subsystem” and a text
“STRATO.EXE The system cannot open the port COM1, which is requested by the
application. Click ‘Close’ to end the application.”

Issue: Strato can handle only COM1 and COM2. Strato is unable to detect the absence of
a COM port and fails.

In data receiving mode, Strato will try open the configured COM port to read data. If
this port does not exist, Strato will crash. In reprocessing and receiving mode, Strato
may try to open the alternate COM port to write the GPS NMEA data stream and the
XDATA packets. If the alternate port does not exist, Strato will crash.

Solution: Open the file STRATO.INI. Verify that the COM port listed in the line “Serial
Port =" exists. This may be COM 1 or COM2, depending on the configuration of the
system.

If either the line “GPS data on serial = Yes” or the line “iMet xdata on serial =Yes” are
set to Yes, then make sure that the alternate port exist as well. In other words, if the
serial port for telemetry data is COM1, make sure COM2 exists. If the serial port for
telemetry data is COM2, make sure COM1 exists. If neither port exists, then set both
lines to

“GPS data on serial = No”
“iMet xdata on serial = No”

To restart the program, wait until the Strato window closes or force closing through the
Windows controls. Then verify the port settings and configurations and restart Strato.

Appendix F: Frequently Asked Questions

What is the ascent balloon velocity? Does it changes for CFH and Ozone?

The nominal ascent velocity of the balloons is 5 m/s. This means that the balloons are
filled such that they will rise at that speed. In reality, the ascent speed varies, and often
is at 6 m/s or more. Since the CFH payload is heavier, the balloon will require more
helium to reach the same speed. Even very large balloons typically rise at that speed.

One interesting observation—for which nobody currently has a good scientific
explanation—is that the CFH or ozone sonde payloads occasionally speed up dramatically
around the tropopause, reaching 10 to 15 m/s, just to slow down to the nominal speed
after crossing the tropopause. Why could that be? Nobody knows at the moment.
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Before adding cryogen, what is the typical frost point temperature?

The temperature that the instrument reports is always the mirror temperature. When
the cryogen is filled and the instrument is running, then it is by definition the same as
the frost point temperature. Before cryogen is filled, the mirror is at ambient
temperature. Since there is a large copper mass on the back side of the mirror, the
mirror temperature will respond only very slowly to ambient temperature changes.

This means that if the instrument has been sitting in an air-conditioned lab for a long
time, it will show roughly that room temperature. If the instrument is then taken
outside, it will still show the lab temperature for quite a while and not the warmer
outside temperature.

During the initial power on phase of the instrument, the mirror heater is turned on for
a short time and mirror temperature may rise to a short peak of 33 to 38 deg C. It will
then cool down to about the temperature it had before.

After adding cryogen, what is the typical frost point temperature? How long
does it take to reach this value?

After it has been filled with cryogen, the instrument tries to regulate the mirror
temperature at the ambient frost point temperature. However, without airflow, this is
nearly impossible for the instrument to do. So the temperature control is very sloppy.
When the cryogen is filled, the temperature begins to decrease without any other
change. When the temperature reaches the ambient dew point temperature, 2
condensation will form on the mirror. The optics voltage will begin to decrease and
subsequently will start to oscillate strongly around the value of 2.5V. The mirror
temperature will cool a few degrees below the ambient dew point and then increase
again. Very often, then mirror temperature will reach about 33C for several seconds and
then cool down again. It will then oscillate around the ambient dew point. This means
that the frost point and the Vaisala frost point should be in the same range, i.e. differ
only by a few deg. The entire process will take a few minutes.

What is the typical detector signal value? How do you know if it is acceptable?

The detector signal before the cryogen is filled should be nearly the same value as the
detector signal (or optics voltage) that was seen in CFH.setup after the mirror cleaning
procedure. A difference of 0.01V is common, but the difference should not be more than
about 0.03V. After the mirror is cleaned and the reflectivity has been set to 88%, the
detector signal is shown in the status fields of CFH.setup. In telemetry mode, this value

2 There will be liquid on the mirror when it is on the ground, not ice.
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is constantly measured and transmitted to the ground. Before the instrument is filled
with cryogen, this temperature should match roughly the measured value in CFH.setup.

What is the typical CFH battery voltage before launch?

The nominal value of the battery is 12V. Under load it is typically at 11V without
cryogen.

What is the typical CFH battery voltage after adding cryogen?

After adding cryogen, when the heater starts working, the battery may go as low as 9
V. Very short periods of 8V are possible, but should not persist more than a few seconds.

What should the ozone pump current range be before the launch?

The ozone pump current should be less than 100 mA. If the pump current is more than
120 mA, then the pump should be checked.

What is the acceptable ozone battery voltage during the telemetry?

The ozone sonde battery is nominally at 18 V and under load is at 14 to 16V. If it has
less than 14 V before launch, it should be changed. New lithium batteries may need to
run for a few seconds to reach their full power, but then stay quite stable.

Appendix G: Material Safety

See the following page for this information.

Appendix H: Revisions to Manual

Rev. Date | Rev. No. Summary of Changes Section
4/14/2014 A-1 Added cautionary note about modem COM port 3.0
needing to be either 1 or 2
Added material safety information Appendix G
05/16/16 B Removed DMT/Droplet Measurement Technologies ALL

address and references.
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